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Lesson 8 — Enter and Pay Bills Lesson Objectives

Lesson Objectives

® Discuss the different ways you can handle bills in QuickBooks
® Learn how to enter a bill in QuickBooks

® Use the Pay Bills window to pay a bill in QuickBooks
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Lesson 8 — Enter and Pay Bills Use QuickBooks for Accounts Payable

Use QuickBooks for Accounts Payable

Some business owners, especially if they own smaller, home-based businesses, pay their vendors’
(suppliers’) bills when they receive them. Most business owners, however, find it more convenient to
pay bills less often. (They also like keeping the cash in the company for as long as possible.) If you
don't plan on paying your bills right away, QuickBooks can help you keep track of what you owe and
when you owe it.

The money you owe for unpaid bills is called accounts payable. QuickBooks uses the Accounts
Payable account to track all the money you owe to suppliers/vendors. Like any QuickBooks balance
sheet account, the Accounts Payable account has a register where you can view all your bills at once.

@
o Step-by-Step: See the Accounts Payable Register

1. Once in Rock Castle Construction, from the Lists menu, choose Chart of Accounts.

2. Double-click 20000 Accounts Payable in the list to open the register for that account (in other
company files, in which account numbers are being used, or perhaps a different account number
is used for this account, just be sure to double-click on the Accounts Payable account).

20000 - Accounts Payable

$ Goto.. | &) Print.. | B2 Edit Transaction [8) QuickReport
DATE NUMBER VENDOR DUE DATE BILLED v PAID BALANCE
TYPE ACCOUNT MEMQ
215/2025 512 Patton Hardware Supplies 400.00 27,269.24 4
BILLPMT 10100 - Checking
215/2025 513 Timberloft Lumber 1,610.00 25,659.24
BILLPMT 10100 - Checking
21512025 514 Sloan Roofing 5,700.00 19,959.24
BILLPMT 10100 - Checking
2115/2025 Keswick Insulation Paid 670.00 20,629.24
BILL 54000 - Job Expenses:54500 - Subcontractors
21512025 Sergeant Insurance 011142027 4,050.00 24 67924
BILL 13100 - Pre-paid Insurance
215/2025 Vu Contracting 12/30/2026 1,250.00 25,020.24
BILL -split-
21512025 12/03 Cal Gas & Electric 12/30/2026 12268 26,05192
BILL 65100 - Utilities:65110 - Gas and Electric Acct #560-82645-99C
215/2025 8059 Thomas Kitchen & Bath 0114i2027 585.00 26,636.92
BILL 54000 - Job Expenses 54300 - Job Materials
B |Number | Vendor ~ |Due Date @ |Billed Paid l
Account * | Memo b
Spits ENDING BALANCE 26,63692
I-Line Show open balance
Sortby  Date, Type, Mumber/Ref = |m| Restore
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Lesson 8 — Enter and Pay Bills Use QuickBooks for Accounts Payable

The register keeps track of each bill you have entered, shows you the due date and keeps a
running balance of all the bills you owe. As a business owner, this helps you forecast your cash

flow, and the QuickBooks Reminders system (found in Company - Reminders) helps you pay
your bills on time.

3. Press Esctwice to close the open (Accounts Payable register and Chart of Accounts) windows.

NOTES

QuickBooks Desktop 2021 Client Training



Lesson 8 — Enter and Pay Bills Enter Bills

Enter Bills

When you receive a bill from a vendor, you should enter it into QuickBooks as soon as you can. This
keeps your cash flow forecast reports up to date and doesn't give you the chance to set the bill aside
and forget it.

@
Step-by-Step: Enter a Bill

1. From the Vendors menu, choose Enter Bills (or choose Enter Bills from the Home page).

Enter Bills
Main Reports oA
. -
«> B B X Beeaeacown B O B &
Find Mew Save Delete aMemorize Print Attach Select Enter Clear Recalculate Pay
- - File: PO Time: Splits Bill
@ il © Credit [+ Bill Received
Name
VENDOR “ - DATE [-‘121’15!2025 -] SIRMARY:
[ REF. NO. | |
ADDRESS ;i :
AMOUNT DUE 'lo_{)(} |
| ‘ BILL DUE [12:2 _ _ 52025 |
TERMS L -
MEMO | J
RECENT TRANSACTIONS
Expenses $0.00 Items $0.00
ACCOUNT | AMOUNT ! M.} CUSTOMER.JOB ! BILL...! CLASS
'
v NOTES
s cose =

2. Inthe Vendor field, enter the vendor name.

3. Inthe Date field, enter the date of the bill.
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Lesson 8 — Enter and Pay Bills Enter Bills

4. |nthe Ref. No. field, enter the bill number.
5. Inthe Amount Due field, type 7500.
6. Enter the appropriate terms as well as any necessary memo information.

7. Use the Expenses tab to enter expenses from the bill and post them directly to expense
accounts (you can use more than one line to refer to different types of expenses) and specify the
dollar amount of each expense’s line. The amounts should add up to the total amount due on the
bill.

Enter Bills =
=

Main  Reporls

¢» B B RBooow 3 § B O B B &

Find New Save Delele €QbMemorize Print Attach Select Enter Clear Recalculate | Pay

File PO Time Spiits Bill
@ Bil @ cregt  Bill Received
Vendor  [REELEETT]
SUMMARY ¢
VENDGR - Davis Business Associates - DATE 1211512025 @
Phone 415-555-2874
REF. NO. 344
sppRess | Davis Business Associates Email kdavis@samplename com
AvoUNTOUE [1,500.00 Open balance 0.00
POz to be received 0
BILL DUE 12/25/2025 [
TERMS -
MEUD
RECENT TRANSACTION (€
Expenses §1,500.00 Hems $0.00
12120123 Check 2,100.00
AGCOUNT AMOUNT MEMO TEReEL
63300 - Printing and Reproduction - 1,450.00 - - |&
54000 - Job Expenses:54520 - Freight & Delivery 50.00
NOTES &

Savo & Closo Clor

8. Click Save & Close to record the bill. (Note, if this were a vendor credit instead of a bill, you
could click on the radio button next to Credit in the top right corner instead of Bill. This would
issue a vendor credit, which, although all the numbers would appear positive as in the bill
example above, would function as a “negative” bill.)

=  IMPORTANT: You can also enter bills and vendor credits directly in the Accounts Payable register, which
may allow for faster data entry. However, this does not provide as much room for memos or allow for
multiple expense accounts, job costing, or making the expenses billable to customers.

NOTES
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Lesson 8 — Enter and Pay Bills Pay Bills

Pay Bills

When you start QuickBooks or open a QuickBooks company file, a Reminders window appears to
tell you whether you have transactions to complete, such as bills to pay or money to deposit. (If you
don't see the Reminders window, turn it on by choosing Preferences from the Edit menu, then
choosing Reminders.)

You can display the Reminders window whenever you want by selecting Company > Reminders.

When QuickBooks tells you that there are bills due, you can display the Pay Bills window and select
the bills you want to pay.

@
o  Step-by-Step: Pay a Bill

1. From the Vendors menu, choose Pay Bills (or click on Pay Bills from the Home page).
2. Ensure the Sort By order is by Vendor.

3. Check the boxes next to the bills you wish to pay. If you wish to pay a certain bill partially, you can
overwrite the amount in the Amt. to Pay column on the far right. If you do not overwrite the Amt.
to Pay figure for a bill, QuickBooks understands that you are paying the total amount outstanding
for that bill.

4 Pay Bills -0 x
SELECT BILLS TO BE PAID
' Due on or before

Show bills
@ Show all bills Filter By -

Sott By vendor -

saTe oUE o e 1o bisc oaTe AT oUE sisc. use seeniTs UseD
12i30/2026 C.U. Electric 500.00 0.00 0.00 500.00 &
01112027 C.U. Electric 250.00 0.00 0.00 250.00 l

Q

=
=l
M 12i30/2026 Cal Gas & Electric 12103 12268 0.00 0.00 0.00
I~ 12/25/2026 Cal Telephone 9194 0.00 0.00 0.00
7 1210i2026 Daigle Lighting 1,539.00 0.00 0.00 1,538.00
| |74 01/01/2027 Daigle Lighting 52.00 0.00 0.00 52.00
I 12/25i2025 Davis Business Associates 344 1,500.00 0.00 0.00 0.00
I~ 01102027 Hamlin Metal 670.00 0.00 0.00 0.00
I 12/20/2026 Hopkins Construction Rentals 550.00 0.00 0.00 550.00
™ 12/23i12026 Hopkins Construction Rentals 150.00 0.00 0.00 0.00
T 12/26/2026 Lew Plumbing 1,200.00 0.00 0.00 0.00
v
Totals 2487772 0.00 0.00 2,891.00

Clear Selections

DISCOUNT & CREDIT INFORMATION FOR HIGHLIGHTED BILL

Vendor Daigle Lighting Terms Net 30 Number of Credits 0
Bill Ref No Sugg. Discount 0.00 Total Credits Available 0.00
Goto Bill Set Discount Set Credits
PAYMENT
Date Method Accaunt
121512025 @ Check - (@ Tobeprinted 10100 - Checking -
7 Assign check number Erdrg Taanee T

Pay Selected Bills Cancel
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Lesson 8 — Enter and Pay Bills Pay Bills

4. Ensure you have the proper payment method settings selected (including To be printed if you're
going to print the Bill Payment Checks), as well as the bank account (or credit card account, if
you're paying by credit card) from which you want the bills to be paid.

5. Click Pay Selected Bills.

In the next window, you can choose to pay more bills, print checks for the selected bills, or click
Done to exit the module and print checks later (if you're paying by check).

Payment Summary x

PAYMEMNT DETAIL 5

Payment Date 1215812025
Payment Account 10100 - Checking
Payment Method Check

FPayments have been successfully recorded for the following 5 of 5 bills:

DATE DUE ! VEMDOR ! AMOUNT FAID
12/30/2026  |C.U. Electric 500.00
0112027 .. Electric 250.00 l
L
Total 2,891.00

How do | find and change a bill payment?

You can print checks now ar print them later from Print Forms on the File menu.

Pay More Bills Print Checks Done

QuickBooks Desktop 2021 Client Training 11



Lesson 8 — Enter and Pay Bills

Pay Bills

If you're paying by manual check, instead of To be printed in the Pay Bills window, you would
have selected Assign check number. In that case, you would see an Assign Check Numbers
window in which you would assign the check numbers to the manual Bill Payment Checks you've

recorded.

a. You can also click the Print Checks icon from the Banking section of the Home page to
access your checks marked To Print in the check register.

- e o

Learn more

&

Statements

COMPANY

1099 1099 tax forms are changing
= Click to see what's new in the 2020 tax year for both contractor and vendor 1099 forms.
VENDORS
& ® &
Purchase Receive Enter Bills Manage Chartof Inventory
Orders Inventory Against Sales Accounts Activities
Inventory Tax
@ @ tems &
Enter Bills Pay Bills Senices
CUSTOMERS
% Calendar
Sales = Create Sales
Orders pocept Receipts
ccep! BANKING
Credit Cards
=N
@ 3 & &
Estimates Create Receive Record Reconcile
Invoices Payments Deposits
B B 4
Statement Finance Refunds
Write Check
Charges Charges &Credits
E B Checks Register
EMPLOYEES
o - = jif &
= @ E% @ Print Enter Credit
Payroll Enter Pay Pay Process Checks Card Charges
Center Time Employess Liabilities Payroll
Forms

You are using a sample

company file

Create a new company file

ACCOUNT BALANCES

i BALANCE

HAME ~

10100
10300
10400
11000
20000 - Accounts ..
20500 - QuickBook.

Checking
savings

Petty Gash

Accounts

DO MORE WITH QUICKEOOKS.

© nnonravar
-
Accept Credit Cards

© oster checks & suonies

0 Clients Outgrowing OB Pro?

BACKUP STATUS

(B, Locak August02, 2020, 9:01AM

Back up now

Online: Back up online with
Intuit Data Protect

10100 - Checking
$ Goto... | £} Print... | [ Edit Transaction QuickReport [2] Download Transactions

487331 4
59,910.19
1,000.00
9394102
25245.02

0.00
v

WHAT'S NEW

IX]

DATE NUMBER PAYEE PAYMENT v DEPOSIT BALANCE
TYPE ACCOUNT MEMO

12M5/2025 | To Print | Vitton, David:Remodel Kitchen 300.00 4042910 4
CHK 11000 - Accounts Receivable

1215/2025 | To Print JC.U. Electric 750.00 39,679.10
BILLPMT §20000 - Accounts Payable

12015/2025 | To Print | Daigle Lighting 1,591.00 38,088.10
BILLPMT 20000 - Accounts Payable

12M5/2025  To Print | Hopkins Construction Rentals 550.00 3753810
BILLPMT 20000 - Accounts Payable

1215/2025 42,000.00 -4,461.90
TRANSFF 10300 - Savings Funds Transfer Ref #4B2786CA

12M15/2025 | SEND 500.00 -3,961.90
TRANSFE 10300 - Savings

12M7/2025 | FAM2011 Abercrombie, Kristy:Remodel Bathroom 763328 -11,595.18
GEMNJRM 11000 - Accounts Receivable Bounced Check#

12M17/2025 | FAM2012 Abercrombie, Kristy:Remodel Bathroom 25.00 -11.620.18

QuickBooks Desktop 2021 Client Training
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Lesson 8 — Enter and Pay Bills

Pay Bills

b. Orto access your checks marked as Print Later in the Main tab of the ribbon (or with a check
number of To print) when the Bill Payment Check is opened.

Bill Payments(Check) - Chec

Main Reporis

oA
& P E 2@ @ Create a Copy E @

(E0) = -
O k & ® &
Find New Save Delete @ Memorize Print Online Bank Pmt Attach Select  Enfer Clear Recalculate Batch Reorder
el = File PO Time Splits Transactions Reminder Ordy
Cher
BANK ACCOUMNT 0 - Checki ENDING BALANCE
i [10100 Checking -] -4,873.33

NO.  To Print
FRINT A5: C. U. Electric

DATE 12152025 HE
F&Y TO THE ORDER OF C.\U. Electric T —

- ]

750.00

Seven hundred fifty and O/{Q0* * **** ** ¥+ s 2 aaxa a2 d4r kA k222 b2 AR AL XL 424+ )| ARG

C. U. Electric
PO. Box 2816
ADDRESS  Bayshore CA94326

MEMO

BILLS PAID IM THIS TRANSACTION:
F.. ! DATEDUE | VENDOR

! REF. NO. ! BILLAMT. | AMT.DUE | DISC. DA
w (1213002026 C.U. Electric

SC.DA... | AMT. PAID
500.00 500.00 500.00 |~

» 01112027 C.U. Electric

Discounts

Save & Close Revert
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Lesson 8 — Enter and Pay Bills

Pay Bills

c. You can also print an individual check or batch of checks waiting to be printed by clicking on

the drop-down under Print in an individual check.

Main Reporis i oA
[ i, = i = = A
e B B X Boooon| g e g o) BE & @ C
Find New  Save Delete @Memorize Print niine Bank Pmt Attach Select  Enter Clear Recalculate Batch Reorder
X = File PO Time Splits Transactions Reminder Ordi
TR =
BANK ACCOUNT [1{}10{] - Checking « Batch ENDING BALANCE 4 873.33
NO.  To Print
FRINT A5: C. U. Electric DATE m
PAY TO THE ORDEROF  [S1) Elecic = s 78000
Seven hundred fifly and D0FI00F **# % =+ % #5225 2 s 2t asaasassnsasssansrsassnsss 0o ane
C. U. Electric
PO. Box 2816
#OPRESS Bayshore CA94326
MEMO
BILLS PAID IN THIS TRAMSACTION:
F.. | DATE DUE ! VENDOR i REF. NO. ! BILLAMT. | AMT.DUE | DISC.DA.. | AMT FAID
" 112/30/2026 C.U. Electric 500.00 500.00 500.00 [~
« (01112027 C.U. Electric 250.00 250.00 250.00
v
Discounts Revert
QuickBooks Desktop 2021 Client Training 14



Lesson 8 — Enter and Pay Bills Pay Bills

d. In addition, you can print any or all of the checks in the print queue at any time by selecting
File > Print Forms > Checks (or Forms - Paychecks if you're using QuickBooks Payroll
and printing paychecks).

® Sample Rock Castle Construction - QuickBooks Premier 2021 (via Accountant)
204 Edit View Lists Favorites Company Customers Vendors Employees Banking Reports Window Help
New Gompany.
Open or Restore Gompany.
§  Open Previous Company

5

are changing 3
Open Second Company new in the 2020 tax year for both contractor and vendor 1099 forms.
Back Up Company »

Create Copy.
Close Company |

Home —oOx

Switch to Multi-user Mode

VENDORS ComPANY
Utities ’
Send Company File v 9 @ % ﬁ
- Receve Enter Bills New: Business Manage Chartof Inventory
- Inventory Against Loans Sales Accounts Adiivities
Inventory Tax
&
SendForms. @ tems & Order
Shipping b Invoices. PayBills Services Checks
App o
: Paychecks. % B
b Toggle to Another Edition. l_w!—l o
g ot AL Tum on Time Calendar
2 =g Purchase Orders. Tracking
sales Sales Orders = Create Sales
Orders | Sales Receipis. Accept Receipis
BANKING
Timesheets. Credit Cards
1099511096
E=) B
B L] i %
Estimates Create Receive Record Reconcile
Invoices Payments Deposits
& 8 &
Statement Finance Statements Refunds e heex
ch ch & Credit
sree argee e Checks Register
EMPLOYEES
& = bt =
Payroll Enter Pay Pay Process Checks Card Charges
Center Time Employees Liatiliies Payrall

Forme

e. You would select the desired Bank Account then place a checkmark next to the checks in the
print queue.

Select Checks to Print

BankAccount 10100 - Checking - First Check Mumber 10080 Order Checks

Select Checks to print, then click QK.
There are 4 Checks to print for $3,191.00.

4 i DATE i PAYEE ! AMOUNT

Y 1211512025 Vitton, David:Remaodel Kitc... SUU.UU| Cancel
¥ 12152025 C.L. Electric 750.00
v
+

Hel
12M5/2025 Daigle Lighting 1,591.00 >

12M15/2025 Hopkins Construction Rent... 550.00 select All

Select None

NOTES
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Lesson 8 — Enter and Pay Bills How QuickBooks Records Your Bill Payment

How QuickBooks Records Your Bill Payment

When you pay $1,500 on a bill through the Pay Bills window, QuickBooks makes an entry in the
Accounts Payable register showing a decrease (debit) of $1,500 in total payables. It also creates a
check (credit) from your chosen bank account to pay the bill. This is a special type of check called a
Bill Payment Check.

Pay Bills -0
SELECT BILLS TO BE PAID
Show bills @ Dugonorbefore  5ononra [
® Show all bills Filter By -
SortBy  vendar i
@ | paTE DUE i VENDOR i REF. NO i DISC. DATE i AMT. DUE i DISC. USED i CREDITS USED i AMT. TO PAY
I~ 12/30/2026 Cal Gas & Electric 1203 122.68 000 000 0.00 &
CalJelephone 9194 0200 000 000
7 12252025 Davis Business Associates 344 1,500.00 0.00 0.00 1,500.00
m B70.00 ToT o0 T
I 12/23/2026 Hopkins Construction Rentals 150.00 0.00 0.00 0.00
- 12i26/2026 Lew Plumbing 1,200.00 0.00 0.00 0.00
I~ 12/27/12026 Lew Plumbing 20001 130.00 000 000 0.00
- 12/24i2026 Middlefield Drywall 1,200.00 000 0.00 0.00
I~ 12i31/2026 Patton Hardware Supplies 210.00 0.00 0.00 0.00
r ownzozz Patton Hardware Supplies 810.00 0.00 0.00 0.00
- 1124/2026 Perry Windows & Doors 1,800.00 0.00 0.00 0.00
v
Totals 21,786.72 0.00 0.00 1,500.00
Clear Selections
DISCOUNT & CREDIT INFORMATION FOR HIGHLIGHTED BILL
Vendor Davis Business Associates Terms MNumber of Credits 0
Bill Ref. No. 344 Sugg. Discount 0.00 Total Credits Available 0.00
Go to Bill Set Discount Set Credits
PAYMENT
Date Method © To be printea Account
12/15i2025 @ Check - ) ) . 10100 - Checking o
Ending Balance -6.373.33

Similarly, if you are paying a bill using a credit card, it creates a payment (credit) from your credit
card account to pay the bill. This is a special type of credit card charge called a Bill Payment Credit
Card.
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Lesson 8 — Enter and Pay Bills How QuickBooks Records Your Bill Payment

@
o Step-by-Step: See the Entry in the Accounts Payable Register

1. From the Company menu, choose Chart of Accounts.

2. Inthe Chart of Accounts, double-click the 20000 Accounts Payable account.

Look for account name or number

NAME i DESCRIPTION i € TYPE i BALANCE TOTAL i ATTACH
+ 10100 - Checking Cash ¢ Bank -6,373.33 4
+ 10300 - Savings Savings ¢ Bank 5991019 |
+ 10400 - Petty Cash Petty Cash Bank 1,000.00
+ 11000 - Accounts Receivable Accounts Receivable Accounts Receivable 93,941.02
+ 12000 - Undeposited Funds Undeposited Funds Other Current Asset 1715734
+ 12100 - Inventory Asset Inventory Asset Other CurrentAsset 30,683.38
» 12800 - Employee Advances Employee Advances Other CurrentAsset 832.00
» 13100 - Pre-paid Insurance Pre-paid Insurance Other CurrentAsset 4,050.00
» 13200 - Prepaid Rent Other CurrentAsset 0.00
+ 13400 - Retainage Recevable Retainage Receivable Other CurrentAsset 3,703.02
'+ 15000 - Furniture and Equipment Furniture and Equipment Fixed Asset 34,326 00
+ 15100 - Vehicles Vehicles Fixed Asset 7893691
+ 15150 - Trailer Fixed Asset 30,000.00
+ 15200 - Buildings and Improvements Buildings and Impravements Fixed Asset 325,000.00
+ 15300 - Construction Equipment Construction Equipment Fixed Asset 15,300.00
+ 16900 - Land Land Fixed Asset 90,000.00
+ 17000 - Accumulated Depreciation Accumulated Depreciation Fixed Asset -110,344.60
» 18700 - Security Deposits Security Deposits OtherAsset
ou owe to vendors and suppliers iy
<+ 20500 - QuickBooks Credit Card ‘QuickBooks Credit Card <« Credit Card
+ 20600 - CalOil Credit Card Credit Card
+ Subcontracted Federal WH Other Current Liability
+ 20700 - Due to Owner Short Term Loan fram Owner - No Note or Band Other Current Liability 0.00
+ 24000 - Payroll Liabilities Payroll Liabilities Other Current Liability 540445
+24010 - Federal Withholding Other Current Liability 1,364.00
+24020 - FICAPayable Other Current Liability 211882
+24030 - AEIC Payable Other Current Liability 0.00
+24040 - FUTAPayable Other Current Liability 100.00
b
Account v Acfivities ¥ | Reports v | Attach  [7) Include inactive

20000 - Accounts Payable X
$ Goto.. | &) Pri | B2 Edit Transaction [5) QuickReport
DA NUNBER VENDOR DUE DATE BILLED v PAID BALANCE
TYPE ACCOUNT MEMO
1201512025 Hopkins Construction Rentals 550.00 17,068.24 L
BILLPMT 10100 - Checking
1211512025 1111 Davis Business Associales 1,500.00 15,568.24
BILLPMT 10100 - Checking
1241512025 Keswick Insulation Paid 670.00 16,238.24
BILL 54000 _Job Expenses 54500 - Subcontraclars
1211512025 Sergeant Insurance 0114/2027 4,050.00 20,288.24
BILL 13100 - Pre-paid Insurance
1211512025 Vu Confracting 12/30/2026 1,250.00 21538.24
BILL -split-
12/15/2025 | 12/03  Cal Gas & Elactric 12/30/2026 122,68 2166092
BILL 65100 - Utilities:65110 - Gas and Electric Acct #560-82645-99C
1215/2025 | 344 Davis Business Associates Paid 1,500.00 23,160.92
BILL split-
1211512025 8059 Thomas Kitchen & Bath 011472027 585.00 23,745.92
BILL 54000 - Job Expenses:54300 - Job Materials
B |Number ||Vendor * |Due Date B |Billed Paid |
Account ~ |Memo ‘n
Spiits ENDING BALANCE 23,745.92
(7] 1-Line (7] Show open balance
Sortby | Date, Type, NumbenRef Restore

3. Close the Accounts Payable register.
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Lesson 8 — Enter and Pay Bills How QuickBooks Records Your Bill Payment

@
o Step-by-Step: See the Bill Payment Entry

1. Inthe Chart of Accounts, double-click 10100 Checking.

= 10100 - Checki P =
& Goto.. | £ Print... | 5 Edit Transaction QuickReport [£] Download Transactions
DATE NUMBER PAYEE PAYMENT vy DEPOSIT BALANCE
TYPE ACCOUNT MEMO

12152025 | 510 Timberloft Lumber 896.00 5941370 4
BILLPMT 20000 - Accounts Payable 1890-76

12M15/2025 | 511 East Bayshore Tool & Supply 696.52 58,717.18
BILLPMT 20000 - Accounts Payable

121502025 512 Patton Hardware Supplies 400.00 58,317.18
BILLPMT 20000 - Accounts Payable RC 93

12152025 | 513 Timberloft Lumber 1,610.00 56,707.18
BILLPMT 20000 - Accounts Payable 1890-76

12152025 | 514 Sloan Roofing 5,700.00 51,007.18
BILLPMT 20000 - Accounts Payable

12152025 | 515 Yu Contracting 1,000.00 50,007.18
CHK 54000 - Job Expenses:54500 - Subcontractors

12M15/2025 | 516 State Board of Equalization 1,629.27 48,377.91
TAXPMT _ -split- ABCD 11-234567

1215/2025 | 1111 Davis Business Associates 1,500.00 46,877.91
20000 - Accounts Payable

12M15/2025 10073 DanT. Miller 1,299.60 45578.31
P&Y CHK -split-

12M15/2025 10074  Elizabeth M. Mason 907.92 44 670.39
P&Y CHK -split-

12M15/2025 10075 | Gregg O. Schneider 1,033.98 43,636.41
P&Y CHK -split-

1215/2025 10076  DanT. Miller 1,350.18 4228626 l
P&Y CHK -split- v

Splits ENDING BALANCE -6 y 373.33
1-Line
Sortby  Date, Type, Number/Ref + m Restore

2. Select the Bill Payment (BILLPMT) transaction you wish to view.
3. Double-click on the transaction or highlight it, then click Edit Transaction on the toolbar.

4. You can edit the transaction or click Save & Close.
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Lesson 8 — Enter and Pay Bills How QuickBooks Records Your Bill Payment

® Here is an example of only one bill owing being paid:

Main Reporis oA
. iy ; 7] =
«r B B X Booeoon ¢ B O E W
Find New Save Delete @ \emorize Attach = Select Enler | Clear Recalculate Reorder
- File PO Time Spiits Reminder = Order
Checks
BANK ACCOUNT - i ENDING BALANCE
K [10100 - Checking -] -6,373.33
No.  [1111
DATE 11211512025 1
FAY TO THE ORDEROF | Dayis Business Associates - $ 150000

Onethousandfive hundred and OO/ 00 * ## #* # # £ 4+ # # # 42+ 4 F £ 2 XXX X2 XXX H2 X2 Loy ape

Davis Business Associates

ADDRESS

MEMO

BILLS PAID IN THIS TRANSACTION:
F.. ! DATE DUE | VENDOR i REF. NO. D BILLAMT, ! AMT.DUE | DISC. DA.. ! AMT. PAID
o '12!25!2025§Davis Business Associates 344 | 1,500.{}0_ 1,5(}0.00_ | 1500.00 [~

Discounts Revert
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Lesson 8 — Enter and Pay Bills

How QuickBooks Records Your Bill Payment

® Here is an example of more than one bill being paid:

Bill Payments(

Main Reports oA
o i i) =
€« B B X Booecw @ rmum g B O E 0w
Find Mew Save Delete {3 Memorize Print | | Online Bank Pmt Attach Select Enfer Clear Recalculate Reorder
7 - File PO Time Splits Reminder = Order
Checks
[ 0100 - Chiecking -] ENDING BALANCE  _§ 373.33
NO. ToPrint
PRINT A5:  (C. U, Electric DATE m
PAY TO THE ORDEROF (1] Elediric =y 3 W
Seven hundred fifty and DOHD0* =+ # 4+ £ % £ 2444 42 #2634 244X 4244 k2442 H 4244 £4%4 0O Luns
. U. Electric
P.O. Box 2316
#PERESS Bayshore CA94326
MEMO
BILLS PAID IM THIS TRANSACTION:
F. ! DATE DUE @ VENDOR i REF. NO. ! BILLAMT. | AMT. DUE | DISC. DA.. | AMT. FAID
» 1213012026 C.U. Electric [ 50000  500.00 500.00| %
. 01M1/2027 C.U. Electic 250.00  250.00 250.00
v
Discounts Revert
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Lesson 8 — Enter and Pay Bills How QuickBooks Records Your Bill Payment

® And finally, here is an example of one of the bills being partially paid. The open balance (i.e.,
the unpaid portion of the bill) will be displayed in Accounts Payable reports as well as the Pay
Bills window.

Bill Payments({Check) - Checking

Main Reporis FE N
a5 " Print Later i = '
¢* B B X Boweoow | @ o o B W
Find Mew  Save Delete @I’v‘;emﬂri:e Print Online Bank Pmt Attach Select Enter Clear Recalculate Reorder
T = File PO Time Spiits Reminder | Order
Checks
BANK ACCOUNT 10100 - Checking - ENDING BALANCE 6 373.33
: 5
MO.  To Frint
DATE |12/15/2025 [

FEY TO THE ORDER OF | Daigle Lighting - ¥ 82150

Eight hundred twenty-one and G0/ 00 = ¥ * £ # # ¥ 2 £ 2 x t X A x A X X A XXX XXX XXX XXXXTXLAALN) 200

PO Box 5803

soomess  Middiefield CA 94482

MEMO

BILLS PAID IN THIS TRANSACTION:

( F..! DATEDUE | VEMDOR | REF. MO ! BILLAMT. | AMT.DUE | DISC. DA.. | AMT. RAID
» 12M0/2026 Daigle Lighting 1,539.00 1,539.00 T69.50
(g » 01/01/2027 Daigle Lighting 5200 52.00 52.00

Discounts Save & Close Revert

= IMPORTANT: You can also open, view or edit this transaction by opening it in the same fashion from the
Accounts Payable register.

NOTES
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Lesson 8 — Enter and Pay Bills Enter and Pay Bills — Review Questions

Enter and Pay Bills - Review Questions

1. You use the account to track money you owe to vendors.

2. List the two steps involved in using the accounts payable features in QuickBooks:

f.

g.

3. When you make a payment (from the checking account) in the Pay Bills window, you can see the
transactions in the and registers.

4. True or false: When tracking accounts payable in QuickBooks, the Enter Bills window is the only
place you can enter bills and vendor credits.

a. True
b. False

5. You paid a vendor $1,000 through the Pay Bills window (using the Checking account).
QuickBooks automatically creates a journal entry that:

a. Deletes the bill
b. Shows $1,000 as a credit in Accounts Payable and $1,000 as a debit in the Checking account
c. Shows $1,000 as a debit in Accounts Payable and $1,000 as a credit in the Checking account

d. Shows $1,000 as a debit in Accounts Payable and $1,000 as a credit in Accounts Receivable
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Lesson 8 — Enter and Pay Bills Review Activities

Review Activities

Use Rock Castle Construction (sample product-based company) to do these activities:
1. Write a check to a vendor assigning the amount to more than one expense account.

2. Enter a bill in the Enter Bills window then view the bill transaction in the Accounts Payable
register.

3. Pay the bill using the Pay Bills window.
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Lesson 8 — Enter and Pay Bills Answers to Review Questions

Answers to Review Questions

1. You use the Accounts Payable account to track money you owe to vendors.

2. List the two steps involved in using the accounts payable features in QuickBooks:
a. v Enter bills
b. v Pay bills

3. When you make a payment (from the checking account) in the Pay Bills window, you can see the
transactions in the Checking and Accounts Payable registers.

4. True or false: When tracking accounts payable in QuickBooks, the Enter Bills window is the only
place you can enter bills and vendor credits.

a. True

b. v False; you can also enter bills and vendor credits directly in the Accounts Payable register,
which may allow for faster data entry.

5. You paid a vendor $1,000 through the Pay Bills window (using the Checking account).
QuickBooks automatically creates a journal entry that:

a. Deletes the bill.
b. Shows $1,000 as a credit in Accounts Payable and $1,000 as a debit in the Checking account.

c. v Shows $1,000 as a debit in Accounts Payable and $1,000 as a credit in the Checking
account.

d. Shows $1,000 as a debit in Accounts Payable and $1,000 as a credit in Accounts Receivable.
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